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Preface
This manual describes the Keil Software MCB520 Evaluation Board and the
8051 software development tools.  The following chapters are included:

“Chapter 1.  Introduction” gives an overview of this user’s guide and provides a
quick start table.

“Chapter 2.  Setup” describes how to connect and configure the board.

“Chapter 3.  Theory of Operation” provides detailed information about the
different sections of the circuit board.

“Chapter 4.  Programming” gives details about how to use our tools to generate
programs for the MCB520 evaluation board.

“Appendix A.  Schematics” contains the schematic drawings for the MCB520.

“Appendix B.  PAL Equations” lists the logic equations for the PLDs used on the
board.

“Appendix C.  DIP Switch and Jumper Settings” provides detailed information
about the DIP switches on the board.

Note
This manual assumes that you are familiar with Microsoft Windows and the
hardware and instruction set of the 8051 microcontroller.
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Document Conventions
This document uses the following conventions:

Examples Description

README.TXT Bold capital text is used for the names of executable programs, data files,
source files, environment variables, and commands you enter at the
MS-DOS command prompt.  This text usually represents commands that
you must type in literally.  For example:

CLS DIR BL51.EXE

Note that you are not required to enter these commands using all capital
letters.

Courier Text in this typeface is used to represent information that displays on
screen or prints at the printer.

This typeface is also used within the text when discussing or describing
command line items.

Variables Text in italics represents information that you must provide.  For example,
projectfile  in a syntax string means that you must supply the actual project
file name.

Occasionally, italics are also used to emphasize words in the text.

Elements that
repeat…

Ellipses (…) are used to indicate an item that may be repeated.

Omitted code
.
.
.

Vertical ellipses are used in source code listings to indicate that a fragment
of the program is omitted.  For example:

void main (void) {
.
.
.
while (1);

�Optional Items� Optional arguments in command-line and option fields are indicated by
double brackets.  For example:

C51 TEST.C PRINT �(filename)�
{ opt1 | opt2 } Text contained within braces, separated by a vertical bar represents a

group of items from which one must be chosen.  The braces enclose all of
the choices and the vertical bars separate the choices.  One item in the list
must be selected.

Keys Text in this sans serif typeface represents actual keys on the keyboard.
For example, “Press Enter to continue.”
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Chapter 1.  Introduction
Thank you for allowing Keil Software to provide you with the MCB520
evaluation board and software for the 8051 microcontroller family.  With this kit
you can generate code and then operate it on the MCB520 evaluation board.
This hands-on process helps you determine hardware and software needs for
current and future product development.

The MCB520 evaluation board helps you become familiar with the different
operating modes of the Dallas Semiconductor 87C520 microcontroller and other
8051 devices that come in 40-pin DIP packages.  By generating and testing code
for the various operating modes of the 87C520 and 8051, you can evaluate code
and processor performance.  These factors can be weighed against other
production parameters to aid in selecting the optimum code and processor
combination.  Alternatively, you may choose just to play with the board, make it
flash the LEDs, and write “Hello World” out the serial port.

This user’s guide describes the hardware of the MCB520 evaluation board and
contains the operating instructions for the 8051 monitor (MON51) and the
MON51 terminal program (MON51.EXE).  MON51 is a configurable monitor
program which is stored on the EPROM provided with the MCB520 board.  It
lets you communicate between your PC and the MCB520 evaluation board so
that you can download and run your 8051 programs.

The MCB520 kit includes the following items:

� MCB520 Evaluation Board User’s Guide (this manual).

� MCB520 Evaluation Board.

� MCB520 Evaluation Board Software.

� 9 Volt DC Wall Transformer.

� 9-pin Serial Cable.

� An 8051 Evaluation Kit which includes a 2K compiler.
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Features
The MCB520 supports a number of powerful features.

Code Banking Support

The MCB520 lets you easily create and test programs that are larger than
64 Kbytes of code space.  Up to 4 code banks are supported using a 256K×8
EPROM or FLASH memory.  You can replace the on-board EPROM with any of
the various 27C010 or 27C020 EPROM devices.

RAM Banking Support

The MCB520 supports RAM banking.  There is no inherent ability in the C51
compiler or linker to support RAM banking.  However, this is relatively easy to
administer yourself.  Up to 2 banks of 64 Kbytes each are supported.

On-Board FLASH Programming

The MCB520 supports 12 Volt FLASH memory devices and has an on-board
12 Volt DC programming power supply.  The following FLASH devices work
with the MCB520.

Manufacturer Part Number Memory Size

Catalyst CAT28F010 128K × 8

CAT28F020 256K × 8

Intel P28F010-65 128K × 8

P28F020-70 256K × 8

SGS Thompson M28F101-90 128K × 8

M28F201-90 256K × 8

Refer to “Programming FLASH Memories” on page 35 to learn how to program
the FLASH memory.
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Dual Serial Ports

The MCB520 provides DE9 connectors for both of the 87C520’s serial ports.
You may use either of these ports for your own programs.

The 8051 monitor program provided with the MCB520 uses serial port 1 (SIO 1)
for communication with the PC.  This leaves serial port 0 (SIO 0) available for
your user programs.

Quick Start
Use the following list to quickly locate important information about the MCB520
evaluation board.

To… See…

Connect power to the MCB520 board. “Connecting the MCB520” on page 6.

Connect the MCB520 to your PC. “Connecting the MCB520” on page 6.

Read about the default configuration settings. “Configuring the MCB520” on page 7.

Create a simple program to blink the LEDs. “Blinking the Port 1 LEDs” on page 28.

Learn more about the µVision IDE. “Using µVision to Create the BLINKY Program”
on page 42.

Learn more about the dScope debugger. “Using dScope to Debug the BLINKY Program”
on page 48.

Read about the DIP switch settings. “Appendix C.  DIP Switch and Jumper Settings”
on page 57.

Configure the RAM/ROM memory. “Memory Architecture” on page 26.

See the MCB520 schematics. “Appendix A.  Schematics” on page 53.

See the MCB520 PAL equations. “Appendix B.  PAL Equations” on page 55.
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Chapter 2.  Setup
Setting up the MCB520 evaluation board is easy. The board requires power and a
serial connection to a PC running the MON51 terminal program.  Before you
start, make sure you have satisfied the following hardware and software
requirements.

Hardware Requirements

� The MCB520 Evaluation Board.

� A serial cable, 9-pin male to 9-pin female, 1-2 meters long, wired one-to-one.

� A power supply capable of providing 9VDC at 500mA.  The power cable
should terminate with a 5.5mm barrel plug with a 2.5mm center hole.
Polarity is irrelevant.

� An IBM compatible PC with an available RS-232 port.  If the port has a
25-pin connector, a 9-pin male to 25-pin female adapter may be required.

� A device programmer is required to program the 87C520 or 8051 and to
program any EPROMs or other programmable devices.  Contact our technical
support group for a list of compatible device programmers.

Software Requirements

� The Keil MON51 terminal program (MON51.EXE).

� The Keil MON51 software/firmware (MON51.HEX).  The monitor is already
programmed into the provided EPROM.

� Microsoft or PC DOS version 3.1 or later.

� Microsoft Windows version 3.1, 3.11 or Windows 95.
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Connecting the MCB520
To use the MCB520 evaluation board, you must:

� Connect it to your PC using the supplied serial cable.

� Connect power using the supplied wall transformer.

The serial cable lets your PC download program code and debug your target
applications.  The power cable provides power to the MCB520 evaluation board.
The MCB520 does not get power from the PC via the serial cable.

Perform the following steps to connect the MCB520 evaluation board.

1. Connect the MCB520 to your PC using the provided serial cable.  Connect
the SIO 1 jack on the MCB520 to an available serial port on your PC.

2. Connect the supplied transformer to an AC wall outlet.  Plug the jack from
the transformer into socket J1 on the board.  The jack is the power switch for
the board.  Simply remove the jack from the socket to turn the unit off and
replace it to power the unit on.

The serial port jack (SIO 1) and the power supply jack (J1) are shown in the
following illustration.

Power
Supply

Jack (J1)

Serial Port
Jack (SIO 1)
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Configuring the MCB520
You select MCB520 evaluation board operating modes using the DIP switches
(labeled SW1 and SW2) on the board.  The MCB520 evaluation board is shipped
with the following configuration:

� Dallas Semiconductor 87C520-MCL.

� External EPROM from 8000h to 0FFFFh (CODE space).

� External SRAM from 0000h to 7FFFh (XDATA/CODE space).

� External SRAM from 8000h to 0FFFh (XDATA space).

� Port 1 connected to LEDs.

� Port pins 3.0 and 3.1 used for serial I/O port 0.

� Port pins 1.2 and 1.3 used for serial I/O port 1.

� Port pin 3.2 used for input from the INT push-button.
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DIP Switches and Jumpers
The following figure shows the location of the DIP switches and jumpers on the
MCB520 board.

The default DIP switch settings are shown in the following tables.

SW1 1 2 3 4 5 6 7 8

ON X X X

OFF X X X X X

SW2 1 2 3 4 5 6 7 8

ON X X X X X X

OFF X X

For more information about the DIP switch settings, refer to “Appendix C.  DIP
Switch and Jumper Settings” on page 57.
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Chapter 3.  Theory of Operation
The MCB520 is designed to be a very flexible evaluation board you can use to
compare the effectiveness of the 87C520 versus the 8051.  Additionally, the
MCB520 supports up to 256K×8 of EPROM or FLASH and 128K×8 of SRAM.
This lets you evaluate large code-banking application programs, flash memory
utilization, and RAM banking.

This chapter describes the logical sections of the MCB520 and provides a circuit
description of each.  The descriptions here show you how the MCB520 board
works and how you can easily interface to various I/O devices.

The following block diagram shows the various memory, I/O, configuration, and
power systems that compose the board.

Inpu t
8 - 9V D C

O utput
5V +/-5%

350m A
Pow er
Supply

D allas 80C 520
C PU

R S232 C h-1

M em ory System

User I/O

R S232 C h-2

40 p in 8051
Header

Reset & Int.

P1 LED sBuffer

C onfigura tion

Buffe rs

R AM R O M /FLASH

O utput
12V +/-5%

100m A

V CC

V PP
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The MCB520 evaluation board can easily be divided into the following logical
sections.

� Power Supply.

� FLASH Programming Power Supply.

� CPU.

� Configuration.

� Buffers and Decode Logic.

� Memory.

� PORT1 (LEDs).

� Push Buttons.

� Serial Ports.

� Prototyping Area.

� Port Pin Assignments.

These logical sections, the components used, and the circuit locations are
described on the following pages.



MCB520 Evaluation Board User’s Guide 11

Power Supply Circuitry
The following figure shows the power supply section of the MCB520.

Power is supplied to the MCB520 from an external 9 Volt DC power supply
which is capable of providing 500mA.  Connection is made using a standard
5.5mm barrel plug with a 2.5mm center hole.  The barrel jack located at J1
accepts such a plug.  Polarity is not important since a full-wave bridge rectifier is
used.  5 Volts DC is provided to the board by the 7805 voltage regulator at VR1.
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FLASH Programming Power Supply
Circuitry
The MCB520 provides a 12VDC programming voltage for programming a
FLASH memory plugged into the ROM socket (U6).  The following figure
shows the FLASH programming voltage section of the MCB520.

To enable the FLASH programming circuitry, you must set both SW1-4 (FOK)
and SW1-5 (FEN) to ON.  Then, set P1.4 low to energize the FLASH VPP power
supply.

Refer to “Programming FLASH Memories” on page 35 for an example of how to
program the FLASH memory.
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CPU Circuitry
The following figure shows the CPU section of the MCB520.

The Dallas Semiconductor 87C520 provided with the MCB520 is an 8051
derivative with 16 Kbytes of internal EPROM space.  This part is located at U1.

A 33.000 MHz oscillator at U3 provides the clock signal for the CPU.  You may
replace the oscillator with any standard clock oscillator module that fits into a
14-pin DIP socket.

Note
Changing the oscillator frequency requires that a new monitor EPROM is
created to support the desired baud rate.
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Configuration Circuitry
The following figure shows the configuration section of the MCB520.

The MCB520 is a very flexible evaluation board.  You may change the operation
of the board using the 2 sets of DIP switches (SW1 and SW2).  Features such as
external or internal code memory, push button inputs, LEDs, memory type
(Harvard or von Neumann), and on-chip serial ports can all be configured using
these switches.

The default settings for the DIP switches are shown in the following tables.

SW1 1 2 3 4 5 6 7 8

ON X X X

OFF X X X X X

SW2 1 2 3 4 5 6 7 8

ON X X X X X X

OFF X X
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Caution
The MCB520 supports EPROM and FLASH devices.  FLASH programming
voltages (12VDC) are controlled via the DIP switches.  Improper DIP switch
settings may damage your memory devices.  In particular, the following setting
could cause component failure:

� Setting FEN (SW1-5) ON could damage the memory device in U6 if that
device does not use a 12VDC programming voltage.

Note
You should RESET the MCB520 after changing the state of any DIP switch.

Refer to “Appendix C.  DIP Switch and Jumper Settings” on page 57 for a
complete description of the DIP switch settings.
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Buffers and Decode Logic Circuitry
The following figure shows the buffers and decode logic section of the MCB520.

Buffers

Like the 8051, the 87C520 multiplexes the address bus (A0-A7) and data
bus (D0-D7) on Port 0.  The MCB520 buffers the 87C520’s lower address byte
(A0-A7) from Port 0 using the 74F573 at U2.

A 74HC540 at U12 drives the 8 red LEDs from the Port 1 output signals.  You
may disable the LEDs by setting the LD DIP switch off.

Decode Logic

All memory address decode logic as well as other signal conversions are
performed by the 16V8 PAL at U4 and the 74HC00 at U9.

Refer to “Appendix A.  Schematics” on page 53 and “Appendix B.  PAL
Equations” on page 55 for a decode logic circuitry and a complete listing of the
PAL equations.
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Memory Circuitry
The following figure shows the memory section of the MCB520.

The MCB520 maps EPROM/FLASH at U6 and RAM at U5 into the memory
address space of the 87C520.  32-pin DIP sockets are provided for the RAM and
EPROM/FLASH.  The MCB520 is provided with a 32K×8 EPROM at U6 and a
128K×8 RAM at U5.

Note
When 28-pin devices are used, they must be installed with pin 14 of the EPROM
in pin 16 of the socket and pins 1 and 2 on JP1 must be shorted.  When 32-pin
devices are used, pins 2 and 3 of JP1 must be shorted.
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PORT 1 (LEDs) Circuitry
The following figure shows the Port 1 LED section of the MCB520.

The MCB520 has eight general purpose LEDs attached to Port 1 (P1.0-P1.7),
one power status LED for VCC (POWER), and one power status LED for
VPP (PROGRAM).

A single green LED (POWER) indicates the power to the board is on.  A single
yellow LED (PROGRAM) indicates that the 12V FLASH programming voltage
is enabled.

Eight red LEDs are optionally connected to the Port 1 outputs through a
74HC540 at U12.  You may disable the LED driver by setting SW2-1 (LD) OFF.
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Push Button Circuitry
The following figure shows the push button section of the MCB520.

The MCB520 is provided with two push buttons.

The RESET push button is connected to the reset circuit and may be used to reset
the CPU.

The INT push button is optionally connected to INT0 (Port 3.2) or T0 (Port 3.4)
of the CPU.  Use SW2-3 (3.4) to connect the INT push button to INT0 (Port 3.2).
Use SW2-4 (3.2) to connect the INT push button to T0 (Port 3.4).
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Serial Port Circuitry
The following figure shows the serial ports section of the MCB520.

The MCB520 supports both on-chip serial ports of the 87C520.  Both use the
MAX232, at U11, to convert between TTL and RS-232 voltage levels.

The MCB520 comes with a 33MHz oscillator.  The reload values for the timers
must take the clock frequency into account.  The following table lists the reload
values for several common baud rates.

Desired
Baud Rate
@ 33MHz TH1

SMOD
(PCON.7 or
WDCON.7)

Actual
Baud Rate
@ 33MHz

1200 0x71 1 1200

2400 0xB8 1 2386

4800 0xDC 1 4774

9600 0xEE 1 9548

19200 0xF7 1 19096

57600 0xFD 1 57290
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Serial Port 0

You may use the T0 and R0 DIP switches to connect and disconnect the on-chip
serial port 0 to the MAX232.  Set these switches ON to connect the transmit and
receive lines of serial port 0 to the MAX232.

Serial port 0 is derived from the internal serial functions of the 8051/87C520
(P3.0/RXD and P3.1/TXD).

The port is configured as a standard 3-wire
interface only.  The handshaking signals are
connected to loop the PC’s signals back.
Refer to the figure at the right to determine
how the DE9 connector for this port is
wired.  Use the DB9 connector at J2 (SIO 0)
for interfacing to serial port 0.

Serial Port 1

You may use the T1 and R1 DIP switches to connect and disconnect the on-chip
serial port 1 to the MAX232.  Set these switches ON to connect the transmit and
receive lines of serial port 1 to the MAX232.

Serial port 1 is derived from the internal serial functions of the 87C520
(P1.2/RXD1 and P1.3/TXD1).

The external UART is configured as a
3-wire interface.  The handshaking signals
loop the PC’s signals back.  The Keil
8051 Monitor (MON51) provided with the
MCB520 is configured to use this serial
port.  This gives you free access to serial
port 0.  Use the DE9 connector at J3 (SIO 1)
for interfacing to serial port 1.
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Prototyping Area
The following figure shows the prototyping section of the MCB520.

A perforated area is provided on the MCB520 for prototyping your own
hardware.  The prototyping area also provides blocks of +5 Volts (VCC) and
ground (GND).

The connector at J4 provides the signals necessary
to create a 40-pin DIP plug for emulating an
87C520 or 8051 in a 40-pin DIP package.  All
signals are provided at the connector.  You may
enable VCC on pin 40 by setting SW2-2 (PR) ON.

The figure at the right shows the pin labels and pin
numbers for the connector.  This connector is
numbered and wired to correspond with a 40-pin
DIP 8051 package.

The signals provided to the J4 connector are driven
directly by the CPU.  Exercise caution to avoid
overloading these signal lines.
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Port Pin Assignments
The MCB520 uses a number of the 87C520’s port pins to control features of the
evaluation board.  You may disable all of these special purpose features using the
on-board DIP switches.  The following table lists the port pins and how they are
used.

Port Pin Usage Description

P0.0-P0.7 A0-A7/D0-D7 This port is dedicated to providing the multiplexed lower address bus
and data bus.

P1.0 Unused This port pin is not used by the MCB520.

P1.1 Unused This port pin is not used by the MCB520.

P1.2 RXD1 When the R1 switch is ON, this port pin is connected, through the
MAX232 at U11, to the input of the SIO 1 serial port connector.

P1.3 TXD1 When the T1 switch is ON, this port pin is connected, through the
MAX232 at U11, to the output of the SIO 1 serial port connector.

P1.4 FEN When the FEN switch is ON, this port pin may be used to enable or
disable the FLASH programming voltage.  A high output from this pin
disables the 12 Volt supply.  A low output enables the 12 Volt supply.

P1.5 RAM A16 This pin provides A16 to the RAM at U5 when the R16 switch is ON.

P1.6 ROM A16 This pin provides A16 to the ROM at U6 when the E16 switch is ON.

P1.7 ROM A17 This pin provides A17 to the ROM at U6 when the E17 switch is ON.

P2.0-P2.7 A8-A15 This port is dedicated to providing the upper address bus.

P3.0 RXD0 When the R0 switch is ON, this port pin is connected, through the
MAX232 at U11, to the input of the SIO 0 serial port connector.

P3.1 TXD0 When the T0 switch is ON, this port pin is connected, through the
MAX232 at U11, to the output of the SIO 0 serial port connector.

P3.2 INT Button This port pin is connected to the output of the INT push button when
the 3.2 switch is ON.  This pin is driven low when the INT push button
is pressed.

P3.3 FOK When the FOK switch is ON, this port pin is connected to the FLASH
programming voltage OK signal from the 12 Volt programming voltage
supply.  This pin is driven low when the programming voltage is good.

P3.4 INT Button This port pin is connected to the output of the INT push button when
the 3.4 switch is ON.  This pin is driven low when the INT push button
is pressed.

P3.5 Unused This port pin is not used by the MCB520.

P3.6 /WR This port pin is dedicated to providing the write strobe for accessing
external RAM.

P3.7 /RD This port pin is dedicated to providing the read strobe for accessing
external RAM.



24 Chapter 3.  Theory of Operation



MCB520 Evaluation Board User’s Guide 25

Chapter 4.  Programming
Writing programs for the MCB520 is relatively simple.  However, before you get
started, there are a few points you should keep in mind.

� The 87C520 begins executing instructions at address 0000h.  The MCB520 is
shipped with the Keil 8051 monitor programmed into the provided EPROM.
When the HRM and VMN switches are ON, the monitor is relocated to
8000h immediately following reset.  This way, your programs can begin
execution starting at 0000h.  If you set the EA DIP switch ON, the monitor
program begins running when you apply power to the board.

� The pre-programmed monitor communicates using SIO 1 at 9600 baud.  The
serial port uses timer 1 to generate the baud rate.  If you write code that
changes timer 1, communications with the monitor will fail.

� If you use the 8051 monitor for loading and running programs via SIO 1, your
programs must begin at address 0000h.

It is easy to create programs you can download using the 8051 monitor.  In fact,
you can even use the same files for making EPROMs.  You do not need to
relocate your programs to run with the Keil 8051 monitor on the MCB520.

First, compile your applications as you normally would.  For example, you may
use the following command line.

C51 MYCODE.C DEBUG OBJECTEXTEND MODDP2

The DEBUG command line option includes debug records in the generated
object file.  The OBJECTEXTEND command line option includes extended
object information in the generated object file.  The MODDP2 command line
option instructs the compiler to utilize the second data pointer of the Dallas
Semiconductor 87C520.

Second, link your object files as you normally would.

BL51 MYCODE.OBJ TO MYFILE

You may use the OH51 utility to create an Intel HEX file from the absolute
object module created by the linker.  Use the following command line to create a
HEX file.

OH51 MYFILE
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You may use either Intel HEX files or absolute object modules with the dScope
debugger and the MON51 terminal program.  Absolute object modules include
source-level debugging information but HEX files do not.

Memory Architecture
The MCB520 evaluation board supports several different memory architectures.

Architecture Description EA HRM VNM

Harvard CODE and XDATA memory area are
physically separate.  There is 64K of CODE
(×4 banks) and 64K of XDATA (×2 banks).

ON OFF OFF

Harvard (Internal) CODE and XDATA memory area are
physically separate.  There is 64K of CODE
(×4 banks) and 64K of XDATA (×2 banks).
The first 16K of CODE memory resides in the
87C520.

OFF OFF OFF

von Neumann Addresses 0000h-7FFFh from the EPROM are
mapped to CODE 0000h-7FFFh.

Addresses 0000h-7FFFh from the RAM are
mapped to XDATA 0000h-7FFFh.

Addresses 8000h-0FFFFh from the RAM are
mapped to CODE and XDATA 8000h-
0FFFFh.

ON OFF ON

von Neumann / HIROM Addresses 0000h-7FFFh from the EPROM are
mapped to CODE 8000h-0FFFFh.

Addresses 0000h-7FFFh from the RAM are
mapped to CODE and XDATA 0000h-7FFFh.

Addresses 8000h-0FFFFh from the RAM are
mapped to XDATA 8000h-0FFFFh.

ON ON ON

The 87C520 CPU provided with the MCB520 has 16K of internal one-time
programmable (OTP) program memory.  This memory is not used since the Keil
8051 monitor is stored in the external EPROM at U6.
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Example Programs
The following example programs demonstrate different features of the MCB520.

Preparing Programs for MON51

There are only a few things to consider when debugging your programs using
MON51.

� The monitor supplied with the MCB520 is configured to run at 33MHz and to
connect to dScope at 9,600 baud.  A different clock frequency will impact the
data rate and cause the connection to fail.

� Communication from the MCB520 to the PC utilizes SIO 1.  This port uses
P1.2 and P1.3 of the MCB520.  All of the Port 1 pins are wired to the
on-board LEDs.  If you write any values to P1.2 or P1.3, the target to host
communication is interrupted and subsequently fails.

� The monitor uses timer 1 to generate the baud rate for serial communications.
If your programs modify timer 1, communications with the monitor will fail.

� After reset, the monitor is relocated to 8000h by the MCB520 hardware.
Your target programs should start at 0000h.  Relocating your target programs
is not required.

� You can configure the dScope CPU driver to enable serial breaks.  This lets
you break out of a program that is running on your target.  When this option
is enabled, the monitor overwrites the interrupt vector used for serial
communication to point to the code in the monitor.  Since your target
program may occupy the code memory from 0000h to 7FFFh, this interrupt
vector may lie within your target program.  To prevent the monitor from
writing over vital parts of your program, either disable serial breaks or add a
dummy interrupt for the monitor to overwrite.  The following example
interrupt function may be used with the monitor provided with the MCB520.
#include <intrins.h>

static void dummy_isr (void) interrupt 7
{
_nop_ ();
_nop_ ();
_nop_ ();
}
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Blinking the Port 1 LEDs

The following simple program, BLINKY, is an exercise you may use to test the
MCB520 and verify that you can use the tools provided to generate a working
program.

BLINKY does nothing more than blink the LEDs on the MCB520 evaluation
board.  The complete source listing for the program is as follows:

#include <reg320.h>
#include <intrins.h>

static void dummy_isr (void) interrupt 7
{
_nop_ ();
_nop_ ();
_nop_ ();
}

void main (void)
{
volatile unsigned int i;

while (1)
  {
  P1 |= 0xF0; /* turn LEDs on */
  for (i = 0; i < 60000; i++);

  P1 &= ~0xF0; /* turn LEDs off */
  for (i = 0; i < 60000; i++);
  }
}

Use the following command line to compile the FLASH example program:

C51 BLINKY.C DEBUG OBJECTEXTEND MODDP2

Use the following command line to link the FLASH example program.

BL51 BLINKY.OBJ

Use the following command line to create a HEX file:

OH51 BLINKY

You may use either Intel HEX files or absolute object modules with the dScope
debugger and the MON51 terminal program.  Absolute object modules include
source-level debugging information but HEX files do not.

Refer to “Using the Windows-Based Tools” on page 42 for an example of how to
use the Windows tools to create this example program.
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Using Serial Port 0

Using serial port 0 (SIO 0) with the MCB520 is easy.  The following example
assumes you are using the standard I/O routines (like printf and scanf) that are
provided with the Keil C51 compiler.

SFRs for Serial Port 0

You must define the special function registers (SFRs) that control the serial port.
Use the following definitions in your code that uses serial port 0.

sfr SBUF0 = 0x99; /* SBUF for SIO 0 */
sbit RI_0 = 0x98; /* RI for SIO 0 */
sbit TI_0 = 0x99; /* TI for SIO 0 */

sfr SCON0 = 0x98; /* SCON for SIO 0 */

sfr TMOD  = 0x89; /* Timer1 definitions */
sfr TH1   = 0x8D;
sbit TR1  = 0x8E;

sfr PCON   = 0x87; /* power control */

Make certain these SFR definitions are included in the examples listed below.

Since there is no standard console on the 8051 microcontroller, using the printf
function to print to the screen and the scanf function to read from the keyboard
may sound a little strange at first.  However, C51 supports two special functions
which define how console input and output are handled.

Putchar Function for Serial Port 0

The putchar function is the base function that outputs characters to the console.
Functions like puts and printf call putchar to output individual characters.  You
may create a custom putchar function to output characters wherever you like.
The following function outputs characters to serial port 0 of the 87C520.

char putchar (char c)
{
while (!TI_0); /* wait until transmitter ready */
TI_0 = 0;
SBUF0 = c; /* output character */
return (c);
}
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_getkey Function for Serial Port 0

The _getkey function is the base function that inputs characters from the
console.  Functions like scanf and getchar call _getkey to input individual
characters.  You may create a custom _getkey function to input characters from
wherever you like.  The following function inputs characters from serial port 0 of
the 87C520.

char _getkey (void)
{
char c;

while (!RI_0); /* wait for a character */
c = SBUF0;
RI_0 = 0; /* clear receive interrupt bit */

return (c);
}

Serial Port 0 Initialization

You must configure serial port 0 before you can use it in your program.  This is
best done in the main C function.

.

.

.
SCON0  = 0x50; /* SCON: mode 1, 8-bit UART, enable rcvr    */
TMOD  |= 0x20; /* TMOD: timer 1, mode 2, 8-bit reload      */
PCON  |= 0x80; /* SMOD_0: double baud rate bit             */
TH1    = 0x71; /* TH1:  1200 baud @ 33.00 MHz              */
TR1    = 1; /* TR1:  timer 1 run                        */
TI_0   = 1; /* TI:   set TI to send first char of UART  */
.
.
.
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The MCB520 comes with a 33MHz oscillator.  The reload values for the timers
must take the clock frequency into account.  The following table lists the reload
values for several common baud rates.

Desired
Baud Rate
@ 33MHz TH1

SMOD_0
(PCON.7)

Actual
Baud Rate
@ 33MHz

1200 0x71 1 1200

2400 0xB8 1 2386

4800 0xDC 1 4774

9600 0xEE 1 9548

19200 0xF7 1 19096

57600 0xFD 1 57290

The following example program combines the example code into a functioning
program.

//-----------------------------------------------
#include <stdio.h>

sfr SBUF0 = 0x99; /* SBUF for SIO 0 */
sbit RI_0 = 0x98; /* RI for SIO 0 */
sbit TI_0 = 0x99; /* TI for SIO 0 */

sfr SCON0 = 0x98; /* SCON for SIO 0 */

sfr TMOD  = 0x89; /* Timer 1 definitions */
sfr TH1   = 0x8D;
sbit TR1  = 0x8E;

sfr PCON   = 0x87; /* power control */

//-----------------------------------------------
char putchar (char c)
{
while (!TI_0); /* wait until transmitter ready */
TI_0 = 0;
SBUF0 = c; /* output character */
return (c);
}

//-----------------------------------------------
char _getkey (void)
{
char c;

while (!RI_0); /* wait for a character */
c = SBUF0;
RI_0 = 0; /* clear receive interrupt bit */

return (c);
}
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//-----------------------------------------------
void main (void)
{
SCON0  = 0x50; /* SCON: mode 1, 8-bit UART, enable rcvr    */
TMOD  |= 0x20; /* TMOD: timer 1, mode 2, 8-bit reload      */
PCON  |= 0x80; /* SMOD_0: double baud rate bit             */
TH1    = 0x71; /* TH1:  reload value for 1200 baud         */
TR1    = 1; /* TR1:  timer 1 run                        */
TI_0   = 1; /* TI:   set TI to send first char of UART  */

while (1)
  {
  printf ("Type a character\r\n");
  printf ("You entered \'%c\'\r\n", (unsigned char) _getkey ());
  }
}

You may use dScope to simulate this program.  When doing so, you may use the
serial I/O window to display and enter characters.
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Using Serial Port 1

You may use serial port 1 (SIO 1) with the MCB520.  The following example
assumes you are using the standard I/O routines (like printf and scanf).

SFRs for Serial Port 1

You must define the special function registers (SFRs) that control the serial port.

sfr SBUF1 = 0xC1; /* SBUF for SIO 1 */
sbit RI_1 = 0xC0; /* RI for SIO 1 */
sbit TI_1 = 0xC1; /* TI for SIO 1 */

sfr SCON1 = 0xC0; /* SCON for SIO 1 */

sfr TMOD  = 0x89; /* Timer1 definitions */
sfr TH1   = 0x8D;
sbit TR1  = 0x8E;

sfr WDCON  = 0xD8; /* Watchdog Control */

Make certain these SFR definitions are included in the examples listed below.

Putchar Function for Serial Port 1

The following function outputs characters to serial port 1 of the 87C520.

char putchar (char c)
{
while (!TI_1); /* wait until transmitter ready */
TI_1 = 0;
SBUF1 = c; /* output character */
return (c);
}

_getkey Function for Serial Port 1

The following function inputs characters from serial port 1 of the 87C520.

char _getkey (void)
{
char c;

while (!RI_1); /* wait for a character */
c = SBUF1;
RI_1 = 0; /* clear receive interrupt bit */

return (c);
}
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Serial Port 1 Initialization

You must configure serial port 1 before you can use it in your program.  This is
best done in the main C function.

.

.

.
SCON1  = 0x50; /* SCON: mode 1, 8-bit UART, enable rcvr    */
TMOD  |= 0x20; /* TMOD: timer 1, mode 2, 8-bit reload      */
WDCON |= 0x80; /* SMOD_1: double baud rate bit             */
TH1    = 0x71; /* TH1:  1200 baud @ 33.00 MHz              */
TR1    = 1; /* TR1:  timer 1 run                        */
TI_1   = 1; /* TI:   set TI to send first char of UART  */
.
.
.

Note
If you use the pre-configured monitor on the MCB520, do not use the above
example code to configure serial port 1.  The monitor already configures it.  Any
changes to the baudrate or timer will result in communication errors.

The MCB520 comes with a 33MHz oscillator.  The reload values for the timers
must take the clock frequency into account.  The following table lists the reload
values for several common baud rates.

Desired
Baud Rate
@ 33MHz TH1

SMOD_1
(WDCON.7)

Actual
Baud Rate
@ 33MHz

1200 0x71 1 1200

2400 0xB8 1 2386

4800 0xDC 1 4774

9600 0xEE 1 9548

19200 0xF7 1 19096

57600 0xFD 1 57290

You may use dScope to simulate I/O from serial port 1.  Since the serial I/O
window in dScope defaults to serial port 0, you must enter the following
command line in the command window:

assign win <s1in >s1out

This assigns the input and output from the serial window to serial port 1.
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Programming FLASH Memories

The MCB520 provides on-board programming support for 128K×8 and 256K×8
FLASH memory devices.  The MCB520 also provides support for code banking
via the R16 and R17 switches.  The following example code provides routines
that let you erase and program a FLASH device.  Refer to “On-Board FLASH
Programming” on page 2 for a list of FLASH devices that are compatible with
the MCB520.

There are a few things to know about the MCB520 before attempting to
programming FLASH memory devices.

� The FLASH programming power supply is normally disabled.  To enable it,
you must set the FEN switch ON and you must bring P1.4 low (0).  Bringing
P1.4 high (1) disables the programming voltage.

� The FLASH 12 Volt programming supply does not stabilize immediately.
Several milliseconds are required for the supply to come up to 12 Volts.  For
this reason, there is a FLASH programming voltage OK signal that your
software can read.  When the FOK switch is ON, P3.3 is connected to this
signal.  When the programming voltage is good, P3.3 is driven low (0).

� When the FLASH programming power supply is enabled, external RAM
(XDATA) is unavailable.  This is because the /WR and /RD lines from the
87C520 are used to access the FLASH device.

� You must erase the entire FLASH memory before programming it.  This
means that the software to actually program the device must reside in the
internal program memory of the 87C520.

� Make sure that the E16 and E17 switches are on so that you can access the
full address space of the FLASH memory.

� Note that 28-pin FLASH devices are not supported.  The programming
voltage is available only on pin 1 of the 32-pin socket at U6.
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The following functions provide a way for you to erase the FLASH memory and
a way for you to program the FLASH.  You should modify these routines to suite
your needs.

/*------------------------------------------------------------------------
FMEM.C

Routines to program the Intel 28F020/010 Flash Memory.
------------------------------------------------------------------------*/
#include <absacc.h>

/*------------------------------------------------
SFR Definitions for port assignments.
------------------------------------------------*/
sbit VPP_NOT_ENABLE = 0x94;
sbit VPP_NOT_OK     = 0x93;
sbit RAM_A16        = 0x95;
sbit ROM_A16        = 0x96;
sbit ROM_A17        = 0x97;

/*------------------------------------------------
Return values.
------------------------------------------------*/
#define FLASH_OK             0
#define FLASH_VPP_FAIL       1
#define FLASH_PROGRAM_FAIL   2
#define FLASH_ERASE_FAIL     3
#define FLASH_CLEAR_FAIL     4

/*------------------------------------------------
FLASH commands.
------------------------------------------------*/
#define CMD_READ_MEMORY      0x00
#define CMD_SETUP_ERASE      0x20
#define CMD_ERASE_VERIFY     0xA0
#define CMD_SETUP_PROGRAM    0x40
#define CMD_PROGRAM_VERIFY   0xC0
#define CMD_RESET            0xFF

#define VPP_PORT             (VPP_NOT_ENABLE)
#define VPP_OK_PORT          (VPP_NOT_OK)

#define VPPH                 0
#define VPPL                 1

#define VPP_OK               0

#define MAX_ERASE_PLSCNT     3000
#define MAX_PROGRAM_PLSCNT   25

/*------------------------------------------------
Definitions for long loops to generate delays.
------------------------------------------------*/
#define DELAY_US1            2UL
#define DELAY_US6            (DELAY_US1 * 6UL)
#define DELAY_US10           (DELAY_US1 * 10UL)
#define DELAY_MS10           (DELAY_US10 * 1000UL)
#define DELAY_MS1000         (DELAY_MS10 * 100UL)
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/*------------------------------------------------------------------------
unsigned char flash_program (
  unsigned long offset,
  unsigned char *buf,
  unsigned int buflen);

This function uses the FLASH programming algorithm presented in the
Intel Flash Memory Vol 1 1995 data book.
------------------------------------------------------------------------*/
unsigned char flash_program (
  unsigned long offset,
  unsigned char *buf,
  unsigned int buflen)
{
data volatile unsigned long i;
data volatile unsigned int  plscnt; /* quick pulse counter */

/*------------------------------------------------
Enable programming voltage and wait for it to
stabilize.
------------------------------------------------*/
VPP_PORT = VPPH; /* set VPP HI */
VPP_OK_PORT = 1; /* enable input on VPP_OK_PORT */

for (i = 0L; i < DELAY_MS1000; i++)
  {
  if (VPP_OK_PORT != VPP_OK) /* if VPP is not good, continue */
    continue;

  goto VPP_GOOD; /* if VPP is good, erase the FLASH */
  }

VPP_PORT = VPPL; /* set VPP LO */

return (FLASH_VPP_FAIL);

/*------------------------------------------------
Loop thru the memory and program/verify each byte.
------------------------------------------------*/
VPP_GOOD:

for (i = 0L; i < DELAY_US10; i++); /* delay for 10us */
for (i = 0L; i < DELAY_US10; i++); /* delay for 10us */

for (plscnt = 0; (plscnt < MAX_PROGRAM_PLSCNT) && (buflen != 0); )
  {
  XBYTE [0]    = CMD_SETUP_PROGRAM;
  XBYTE [offset] = *buf; /* program byte */

  for (i = 0L; i < DELAY_US10; i++); /* delay for 10us */

  XBYTE [0] = CMD_PROGRAM_VERIFY;
  if (XBYTE [0] != *buf) /* if byte is not programmed, try again */
    {
    plscnt++;
    continue;
    }
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  buflen--;
  buf++;
  offset++;
  }

/*------------------------------------------------
Enable memory reads.
------------------------------------------------*/
XBYTE [0] = CMD_READ_MEMORY;

/*------------------------------------------------
Disable programming voltage and wait for it to
stabilize.
------------------------------------------------*/
VPP_PORT = VPPL; /* set VPP LO */
VPP_OK_PORT = 1; /* enable input on VPP_OK_PORT */

for (i = 0L; i < DELAY_MS1000; i++)
  {
  if (VPP_OK_PORT != VPP_OK) /* if VPP is good, continue */
    break;
  }

/*------------------------------------------------
------------------------------------------------*/
return ((plscnt >= MAX_PROGRAM_PLSCNT) ? FLASH_PROGRAM_FAIL : FLASH_OK);
}

/*------------------------------------------------------------------------
------------------------------------------------------------------------*/
static unsigned int flash_clear_block (
  unsigned int plscnt)
{
data volatile unsigned long i; /* temp var */
data volatile unsigned long addr; /* address */

for (addr = 0L; (plscnt < MAX_PROGRAM_PLSCNT) && (addr < 0x00010000); )
  {
  XBYTE [0]    = CMD_SETUP_PROGRAM;
  XBYTE [addr & 0xFFFF] = 0; /* program 0 */

  for (i = 0L; i < DELAY_US10; i++); /* delay for 10us */

  XBYTE [0] = CMD_PROGRAM_VERIFY;
  if (XBYTE [0] != 0) /* if byte is not programmed, try again */
    {
    plscnt++;
    continue;
    }

  addr++;
  }

return (plscnt);
}
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/*------------------------------------------------------------------------
------------------------------------------------------------------------*/
static unsigned int flash_erase_block (
  unsigned int plscnt)
{
data volatile unsigned long i; /* temp var */
data volatile unsigned long addr; /* address */

for (addr = 0L; (plscnt < MAX_ERASE_PLSCNT) && (addr < 0x00010000);
plscnt++)
  {
  XBYTE [0] = CMD_SETUP_ERASE;
  XBYTE [0] = CMD_SETUP_ERASE;

  for (i = 0L; i < DELAY_MS10; i++); /* delay for 10ms */

  for (; addr < 0x00010000; addr++)
    {
    XBYTE [addr & 0xFFFF] = CMD_ERASE_VERIFY;

    for (i = 0L; i < DELAY_US6; i++); /* delay for 6us */

    if (XBYTE [0] != 0xFF) /* if byte is not erased, try again */
      break;
    }
  }

return (plscnt);
}

/*------------------------------------------------------------------------
unsigned char flash_erase (void);

This function uses the Quick Erase algorithm presented in the
Intel Flash Memory Vol 1 1995 data book.
------------------------------------------------------------------------*/
unsigned char flash_erase (void)
{
data volatile unsigned long i;
data volatile unsigned int  plscnt; /* quick pulse counter */
data unsigned char retval;

/*------------------------------------------------
Enable programming voltage and wait for it to
stabilize.
------------------------------------------------*/
VPP_PORT = VPPH; /* set VPP HI */
VPP_OK_PORT = 1; /* enable input on VPP_OK_PORT */

for (i = 0L; i < DELAY_MS1000; i++)
  {
  if (VPP_OK_PORT != VPP_OK) /* if VPP is not good, continue */
    continue;

  goto VPP_GOOD; /* if VPP is good, erase the FLASH */
  }
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VPP_PORT = VPPL; /* set VPP LO */

return (FLASH_VPP_FAIL);

/*------------------------------------------------
Loop thru the memory and program each byte to 0.
------------------------------------------------*/
VPP_GOOD:

for (i = 0L; i < DELAY_US10; i++); /* delay for 10us */
for (i = 0L; i < DELAY_US10; i++); /* delay for 10us */

plscnt = 0;

for (i = 0; i < 4; i++)
  {
  ROM_A17 = ((i & 0x02) ? 1 : 0);
  ROM_A16 = ((i & 0x01) ? 1 : 0);

  if ((plscnt = flash_clear_block (plscnt)) >= MAX_PROGRAM_PLSCNT)
    {
    retval = FLASH_CLEAR_FAIL;
    goto ERASE_EXIT;
    }
  }

/*------------------------------------------------
Loop thru the memory and erase/verify each byte.
------------------------------------------------*/
plscnt = 0;

for (i = 0; i < 4; i++)
  {
  ROM_A17 = ((i & 0x02) ? 1 : 0);
  ROM_A16 = ((i & 0x01) ? 1 : 0);

  if ((plscnt = flash_erase_block (plscnt)) >= MAX_ERASE_PLSCNT)
    {
    retval = FLASH_ERASE_FAIL;
    goto ERASE_EXIT;
    }
  }

retval = FLASH_OK;

/*------------------------------------------------
Enable memory reads.
------------------------------------------------*/
ERASE_EXIT:
XBYTE [0] = CMD_READ_MEMORY;

/*------------------------------------------------
Disable programming voltage and wait for it to
stabilize.
------------------------------------------------*/
VPP_PORT = VPPL; /* set VPP LO */
VPP_OK_PORT = 1; /* enable input on VPP_OK_PORT */
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for (i = 0L; i < DELAY_MS1000; i++)
  {
  if (VPP_OK_PORT != VPP_OK) /* if VPP is good, continue */
    break;
  }

/*------------------------------------------------
------------------------------------------------*/
return (retval);
}

/*------------------------------------------------------------------------
EOF
------------------------------------------------------------------------*/
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Using the Windows-Based Tools
This section leads you step-by-step through the process of creating the BLINKY
example program and testing it using the µVision IDE and dScope debugger.

Using µVision to Create the BLINKY Program

To create the BLINKY example program using µVision, you must perform the
following steps:

� Create the BLINKY.C source file.

� Create the BLINKY project file.

� Include BLINKY.C in the project.

� Set the C51 compiler options for the project.

� Set the BL51 linker options for the project.

� Set the path specifications for the 8051 tools (if necessary).

� Set the make options for the project.

� Build the project.

Each of these steps is described in detail below.

Starting µVision

In Windows 3.1, start µVision by double-clicking on the icon in the 8051 Tools
group.  In Windows 95, start µVision by clicking the Start button on the task bar
and selecting the appropriate kit from the Program menu.



MCB520 Evaluation Board User’s Guide 43

Creating the BLINKY.C Source File

When µVision starts, select the New command from the File menu and µVision
opens a new text window in which you may create the BLINKY program.  Enter
the BLINKY example program shown on page 28.  Your screen should look
something like the following figure.

You should save the BLINKY program after you enter it.  Select the Save As…
command from the File menu and µVision displays the Save As dialog box
shown below.

To save the program as BLINKY.C, enter BLINKY.C in the File Name text box
at the top of the Save As dialog box.  You may want to save the BLINKY
program and the other files you create in a separate directory.  This example uses
C:\BLINKY for the source files and project files.
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Creating the BLINKY Project File

After you save BLINKY.C, you should create a BLINKY project file.  A project
file contains a list of all the source files in your project as well as the options to
use for the compiler, assembler, linker, and make facility.  Additionally, the
project manager helps you compile, link, and test your target program.

To create a project file for BLINKY, select the New Project… command from
the Project menu.  µVision displays the dialog box shown below.  Enter the
name for the project in the File Name text box.  This example uses
BLINKY.PRJ.

Note
You should always use PRJ as the file extension for project files.

Including BLINKY.C in the Project

When the project file is created, µVision displays the Project Manager dialog
box.  Here, you select the source files to include in your project.
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Click the Add button and choose the BLINKY.C file from the file list.  Click the
Close button to close the file selection dialog box.  Then, click the Save button to
save your changes to the project file.

To return to the Project Manager dialog box, select the Edit Project… command
from the Project menu.

When you have created a project file and inserted the source files into the
project, you are ready to set the options for the compiler, linker, and other tools.

Setting the C51 Compiler Options for the Project

To set the C51 compiler options, select the C51 Compiler… command from the
Options menu and µVision displays the C51 Compiler Options dialog box.
Then, follow these steps:

� Click the Default button.  This restores the default command line settings for
the compiler.

� Click on the Object tab at the top of the dialog box.  This displays the Object
options for the compiler.

� Select the Include debug information check box.

� Select the Include extended debug information check box.

� Click on the Memory Model tab at the top of the dialog box.

� Select AMD & Dallas Semi under the Number of Data Pointers caption.  This
instructs the compiler to generate code that utilizes the second data pointer
available on the 87C520.
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Note
In any of the option dialog boxes, you may click the Default button to restore the
controls to the default settings.

Setting the BL51 Linker Options for the Project.

To set the BL51 linker options, select the BL51 Code Banking Linker…
command from the Options menu and µVision displays the BL51 Linker Options
dialog box.  Then, follow these steps:

� Click the Default button.  This restores the default command line settings for
the linker.

� Click on the Size/Location tab at the top of the dialog box.

� Set the RAM Size to 256.  This tells the linker that 256 bytes of internal data
memory are available on the 87C520.
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Setting the Path Specifications for the 8051 Tools

You may wish to specify the path to the 8051 tools directly in µVision rather
than rely on the settings in AUTOEXEC.BAT.  You may do this in the
Environment Pathspecs dialog box.  Open this dialog box using the
Environment Pathspecs… command in the Options menu.

You may specify the path to BIN directory, the INC directory, and the LIB
directory.  Additionally, you may specify a temporary directory for the compiler
and linker to use when compiling and linking.

Setting the Make Options for the Project

Finally, the make options control how µVision processes the files in your
project.  Open the Make Options dialog box by selecting the Make… command
in the Options menu and click the Default button.  This restores the default make
options which work perfectly for most applications.

Building the Project

Now, you are ready to build the BLINKY project.  Select the
Make: Build Project command from the Project menu to begin compiling and
linking.  µVision responds by compiling the BLINKY.C source file and linking
it with the appropriate library files.
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This process is called making the project.  While the make is running, µVision
displays the status as shown below.

If errors occur during the make process, a message window appears.  If there
were warnings or errors in your source file, you may interactively select the error
and see the corresponding line in your source file.

When make completes successfully, you are ready to begin debugging the
BLINKY program.

Using dScope to Debug the BLINKY Program

To load the BLINKY in the MCB520 evaluation board using dScope, you need
to perform the following steps:

� Load the MON51.DLL CPU driver.

� Configure the CPU driver for the appropriate COM port and baud rate.

� Configure the CPU driver for serial break.

� Load the BLINKY program.

� Step through the BLINKY program.

Each of these steps is described in detail below.

Starting dScope

Start dScope by selecting the dScope Debugger… command from the Run menu
in µVision.  This loads dScope and sets the current path to the path in which your
project file is saved.
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When dScope starts, a screen similar to the following displays.

To load the MON51.DLL CPU driver, type the following in the command
window.

load mon51.dll

This is shown in the following figure.

Typically, the first time you load the CPU driver for the 8051 monitor, you must
set the COM port and baud rate.  If dScope cannot determine the COM port and
the baud rate automatically, the following dialog box appears informing you that
dScope could not find the target system.
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When using the MCB520 evaluation board, the baud rate should be set for 9,600
baud.  You must determine which COM port you are using.

Next, you should configure the CPU driver to enable serial breaks.  To do this,
select the Configuration command from the Peripherals menu.  dScope displays
the Configuration dialog box shown below.

Finally, you are ready to load the BLINKY program.  To do so, type the
following in the command window.

load blinky /* this loads the blinky program */

g,main /* this steps over the startup code */
/* and stops on the first line of main */

Once BLINKY is loaded, the module window displays the BLINKY program as
shown in the following figure.

You may now single step through the BLINKY program by clicking on the
StepOver button on the right side of the module window.  As you step through
the program, you should see the LEDs on the MCB520 changing.
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You may display the status of the I/O ports in dScope.  Select the I/O-Ports
command from the Peripherals menu and dScope displays the following dialog
box.

As you step through the BLINKY program, you will see how the Parallel Ports
dialog box mirrors the LEDs on the MCB520 evaluation board.

When you are ready to exit dScope, click on the Stop button in the module
window and select the Exit command in the File menu.

Note
You must stop the simulation of your target program before you can exit dScope.
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Appendix A.  Schematics
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Appendix B.  PAL Equations
This appendix lists the PAL equations for the 16V8 logic device at U4.  This
device performs address decoding for the EPROM (U6) and RAM (U5) for
Harvard and von Neumann modes.

Name      520PAL;
Partno    PLD001;
Date      3/23/96;
Revision  03;
Designer  Chambers/Ward;
Company   ProDevelopment/Keil Software;
Device    G16V8;

/*------------------------------------------------
Inputs
------------------------------------------------*/
pin 1     = !RD;         /* RAM Read Line from 87C520 */
pin 2     = !WR;         /* RAM Write Line from 87C520 */
pin 3     = !PSEN;       /* ROM Read Line from 87C520 */
pin 4     = !FLASH;      /* True if writes go to FLASH */
pin 5     = A15;         /* A51 from 87C520 */
pin 6     = !HIROM;      /* HRM DIP Switch-true for ROM from 8000-FFFF */
pin 7     = !VONNEUMAN;  /* VNM DIP Switch-true for von Neumann arch */
pin 8     = ROMSW;       /* False=ROM: 0000-7FFF, True=ROM: 8000-FFFF */
pin 11    = RESET;       /* RESET Line */

/*------------------------------------------------
Outputs
------------------------------------------------*/
pin 13    = !QA15;       /* Qualified A15 */
pin 15    = !ROMWR;      /* Write line to FLASH/EPROM */
pin 16    = !ROMRD;      /* Read line to FLASH/EPROM */
pin 18    = !RAMWR;      /* Write line to RAM */
pin 19    = !RAMRD;      /* Read line to RAM */

/*------------------------------------------------
MCB520 RAM/ROM Decode Logic
------------------------------------------------*/
QA15  = !RESET & PSEN & A15 & HIROM;

RAMRD = !FLASH & (RD
      # (PSEN & VONNEUMAN & !A15 &  ROMSW)
      # (PSEN & VONNEUMAN &  A15 & !ROMSW));

RAMWR = WR & !FLASH;

ROMRD = (FLASH & RD)
      # (!FLASH & ((PSEN & !VONNEUMAN)
      # (PSEN &  VONNEUMAN & !A15 & !ROMSW)
      # (PSEN &  VONNEUMAN &  A15 &  ROMSW)));

ROMWR = WR & FLASH;

/* End Of File */
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Appendix C.  DIP Switch and Jumper
Settings

You configure the MCB520 using the on-board DIP switches SW1 and SW2 and
the jumper JP1.  These switches are shown in the following figure.

Note
A DIP switch is ON when it is positioned toward the center of the MCB520
board.  A DIP switch is OFF when it is positioned toward the bottom edge of the
MCB520 board.

The default switch settings are shown in the following tables.  When you receive
your MCB520 evaluation board, the DIP switches should be set as indicated.

SW1 1 2 3 4 5 6 7 8

ON X X X

OFF X X X X X

SW2 1 2 3 4 5 6 7 8

ON X X X X X X

OFF X X

The following sections describe each of the configuration switches and jumpers.
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JP1:  Default 1-2 Shorted

The JP1 jumper selects whether or not pin 30 on the ROM socket is connected to
VCC or to the E17 DIP switch.  This allows the MCB520 board to support both
28-pin and 32-pin memory devices.

When pins 1 and 2 of JP1 are shorted, VCC is provided to pin 30 of the ROM
socket.  This corresponds to pin 28 of a 28-pin memory device.

When pins 2 and 3 of JP1 are shorted, pin 30 of the ROM is connected to the
output of the E17 DIP switch.  This setting should be used for all 32-pin memory
devices.

E17 (SW1-1):  Default OFF

The E17 switch selects whether or not P1.7 of the 87C520 is connected to A17
of the EPROM.  If this switch is ON, the port pin is connected to A17.  If this
switch is OFF, A17 is connected to GND.

E16 (SW1-2):  Default OFF

The E16 switch selects whether or not P1.6 of the 87C520 is connected to A16
of the EPROM.  If this switch is ON, the port pin is connected to A16.  If this
switch is OFF, A16 is connected to GND.

R16 (SW1-3):  Default OFF

The R16 switch selects whether or not P1.5 of the 87C520 is connected to A16
of the RAM.  If this switch is ON, the port pin is connected to A16.  If this
switch is OFF, A16 is connected to GND.

FOK (SW1-4):  Default OFF

The FOK switch selects whether or not P3.3 of the 87C520 is connected to the
FLASH programming voltage OK signal.  If this switch is ON, the port pin is
connected to the OK signal.  If this switch is OFF, the port pin is not connected.
Refer to “Programming FLASH Memories” on page 35 for more information
about programming FLASH memory.
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FEN (SW1-5):  Default OFF

The FEN switch selects whether or not P1.4 is used to enable the FLASH
programming voltage.  If this switch is ON, the port pin enables (when low) or
disables (when high) the FLASH programming voltage.  If this switch is OFF,
the FLASH programming voltage is disabled.  Use the FOK switch to read the
status of the FLASH programming voltage supply.  Refer to “Programming
FLASH Memories” on page 35 for more information about programming
FLASH memory.

EA (SW1-6):  Default ON

The EA switch selects whether or not the CPU executes internal program code or
external program code after reset.  When EA is ON, program code stored in the
EPROM/FLASH is executed after reset.  When EA is OFF, program code stored
in the CPU is executed after reset.

HRM (SW1-7):  Default ON
VNM (SW1-8):  Default ON

The VNM and HRM switches select the type of memory architecture supported
by the MCB520.  The possible memory architectures are described in the
following table.

Architecture Description HRM VNM

Harvard CODE and XDATA memory area are physically
separate.  There is 64K of CODE (× 4 banks) and 64K
of XDATA (× 2 banks).

OFF OFF

von Neumann Addresses 0000h-7FFFh from the EPROM are
mapped to CODE 0000h-7FFFh.

Addresses 0000h-7FFFh from the RAM are mapped to
XDATA 0000h-7FFFh.

Addresses 8000h-0FFFFh from the RAM are mapped
to CODE and XDATA 8000h-0FFFFh.

OFF ON

von Neumann / HIROM Addresses 0000h-7FFFh from the EPROM are
mapped to CODE 8000h-0FFFFh.

Addresses 0000h-7FFFh from the RAM are mapped to
CODE and XDATA 0000h-7FFFh.

Addresses 8000h-0FFFFh from the RAM are mapped
to XDATA 8000h-0FFFFh.

ON ON
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LD (SW2-1):  Default ON

The LD switch selects whether or not the 8 red LEDs that are attached to U12
will illuminate based on output from Port 1.  If LD is ON, the LEDs will light.  If
LD is OFF, the LEDs will not light.

PR (SW2-2):  Default OFF

The PR switch determines if VCC is connected to pin 40 of the header connector
at J4.  If PR is ON, VCC is connected to pin 40.  If PR is OFF, pin 40 floats.

3.2 (SW2-3):  Default ON
3.4 (SW2-4):  Default OFF

The 3.2 switch selects whether or not the INT push button is connected to P3.2
of the 87C520.  If this switch is ON, the INT push button is connected to P3.2.
If this switch is OFF, the INT push button is disconnected from P3.2.

The 3.4 switch selects whether or not the INT push button is connected to P3.4
of the 87C520.  If this switch is ON, the INT push button is connected to P3.4.
If this switch is OFF, the INT push button is disconnected from P3.4.

T1 (SW2-5):  Default ON

The T1 switch controls whether or not the microprocessor’s internal serial port 1
input is connected to the MAX232A and to the internal serial port connector.
When T1 is ON, output from Port 1.3 is connected to the MAX232A RS-232
line driver.  When T1 is OFF, Port 1.3 is disconnected from the MAX232A.

R1 (SW2-6):  Default ON

The R1 switch controls whether or not the microprocessor’s internal serial port 1
input is connected to the MAX232A and to the internal serial port connector.
When R1 is ON, Port 1.2 is connected to the MAX232A RS-232 line driver.
When R1 is OFF, Port 1.2 is disconnected from the MAX232A.
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T0 (SW2-7):  Default ON

The T0 switch controls whether or not the microprocessor’s internal serial port 0
input is connected to the MAX232A and to the internal serial port connector.
When T0 is ON, output from Port 3.1 is connected to the MAX232A RS-232
line driver.  When T0 is OFF, Port 3.1 is disconnected from the MAX232A.

R0 (SW2-8):  Default ON

The R0 switch controls whether or not the microprocessor’s internal serial port 0
input is connected to the MAX232A and to the internal serial port connector.
When R0 is ON, Port 3.0 is connected to the MAX232A RS-232 line driver.
When R0 is OFF, Port 3.0 is disconnected from the MAX232A.
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